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References
    Chapter OBJECTIVES
In this chapter, you will learn:
• About external references and their applications.
• About dependent symbols.
• To use the External References Palette.
• To use the Attach, Unload, Reload, Detach, and Bind options.
• To edit the path of an xref.
• The difference between the Overlay and Attachment options.
• The use of the Attach tool. 
• To work with Underlays.
• To use the DesignCenter to attach a drawing as an xref.
• To use the Bind tool to add dependent symbols.
• To use the Clip tool to clip xref drawings.
• To use the REFEDIT command for in-place editing.
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External References			       
The external reference feature allows you to reference an external drawing without making that 
drawing a permanent part of the existing drawing. For example, assume that we have an assembly 
drawing ASSEM1 that consists of two parts, SHAFT and BEARING. The SHAFT and BEARING 
are separate drawings created by two CAD operators or provided by two different vendors. We 
want to create an assembly drawing from these two parts. One way to create an assembly drawing is 
to insert these two drawings as blocks by using the Insert tool in the Block panel. Now assume 
that the design of BEARING has changed due to customer or product requirements. To update 
the assembly drawing, you have to make sure that you insert the BEARING drawing after the 
changes have been made. If you forget to update the assembly drawing, then the assembly drawing 
will not reflect the changes made in the piece part drawing. In a production environment, this 
could have serious consequences.

You can solve this problem by using the external reference facility, which lets you link the piece 
part drawings with the assembly drawing. If the xref drawings (piece part) get updated, the 
changes are automatically reflected in the assembly drawing. This way, the assembly drawing 
stays updated, no matter when the changes were made in the piece part drawings. There is no 
limit to the number of drawings that you can reference. You can also have nested references. For 
example, the piece part drawing BEARING could be referenced in the SHAFT drawing, then 
the SHAFT drawing could be referenced in the assembly drawing ASSEM1. When you open or 
plot the assembly drawing, AutoCAD LT automatically loads the referenced drawing SHAFT 
and the nested drawing BEARING. When using External References, several people working 
on the same project can reference the same drawing and all the changes made are displayed 
everywhere the particular drawing is being used.

If you use the Insert tool to insert the piece parts, the piece parts become a permanent part 
of the drawing, and therefore, the drawing file size increases. However, if you use the external 
reference feature to link the drawings, the piece part drawings are not saved with the assembly 
drawing. AutoCAD LT only saves the reference information with the assembly drawing; therefore, 
the size of the drawing is minimized. Like blocks, the xref drawings can be scaled, rotated, or 
positioned at any desired location, but they cannot be exploded. You can also use only a part of 
the Xref by making clipped boundary of Xrefs. 

Tip
External referenced drawings are useful for creating parts or subassemblies and then putting 
them together in one drawing to create the main assembly. You can also use it for laying out the 
contents of a drawing with multiple views before plotting.

Dependent Symbols
When you use the Insert tool to insert a drawing, the information about the named objects is 
lost, if names are duplicated. However, if they are unique, they are imported. The named objects 
are entries such as blocks, text styles and layers. For example, if the assembly drawing has a layer 
Hidden of green color and HIDDEN linetype and the piece part Bearing has also a layer Hidden 
of blue color and HIDDEN2 linetype, the values set in the assembly drawing will override the 
values of the inserted drawing when the Bearing drawing is inserted in the assembly drawing 
(Figure 16-1). As a result, in the assembly drawing, the layer Hidden will retain green color and 
HIDDEN linetype, ignoring the layer settings of the inserted drawing. Only those layers that 
have the same names are affected. The remaining layers that have different layer names are 
added to the current drawing.

In the xref drawings, the information about the named objects is not lost because AutoCAD LT 
will create additional named objects such as specified layer settings, as shown in Figure 16-2. 
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Figure 16-1  Partial view of the layer settings of the current drawing in the Layer Properties 
Manager dialog box

For xref drawings, these named objects become dependent symbols (features such as layers, 
linetypes, object color, text style, and so on).

Figure 16-2  Xref creates additional layers

The layer Hidden of the xref drawing (c16d3) is appended with the name of the xref drawing 
Bearing, and the two are separated by the vertical bar symbol (|). The names of these layers 
appear in light gray color in the Layer Properties Manager or Layer drop-down list of the 
Layers panel in the Home tab. These layers can neither be selected nor be made current. The 
layer name Border changes to c16d3|Border. Similarly, CEN is renamed as c16d3|CEN and 
OBJ is renamed as c16d3|OBJ (Figure 16-2). The information added to the current drawing is 
not permanent. It is added only when the xref drawing is loaded. If you detach the xref drawing, 
the dependent symbols are automatically erased from the current drawing.

When you xref a drawing, AutoCAD LT does not let you reference the symbols directly. For 
example, you cannot make the dependent layer, c16d3|Border, as current layer. Therefore, you 
cannot add any objects to that layer. However, you can change the color, linetype, lineweight, 
plotstyle, or visibility (on/off, freeze/thaw) of the layer in the current drawing. If the Retain 
changes to Xref layers check box in the External References (Xrefs) area of the Open and Save 
tab of the Options dialog box is cleared, which also implies that the system variable VISRETAIN 
is set to 0, the settings are retained only for the current drawing session. This means that when 
you save and exit the drawing, the changes are discarded and the layer settings return to their 
default status. If this check box is selected (default), which also implies that the VISRETAIN 
variable is set to 1, layer settings such as color, linetype, on/off, and freeze/thaw are retained, and 
they are saved with the drawing and used when you open the drawing the next time. Whenever 
you open or plot a drawing, AutoCAD LT reloads each Xref in the drawing and as a result, the 
latest updated version of the drawing is loaded automatically.

Note
You cannot make the xref-dependent layers current in a drawing. When the xref drawing is 
bound to the current drawing by using the XBIND command, then only you can make the 
xref-dependent layers a permanent part of the current drawing and use them. The XBIND 
command will be discussed later in this chapter.
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Managing External References in a Drawing
  Ribbon:  View > Palettes > External References Palette			    	    	  
  Menu Bar:  Insert > External References			         Command: XREF	

When you choose the External References 
Palette button from the Palettes panel 
(Figure 16-3), AutoCAD LT displays the 
External References palette (Figure 16-4). 
The External References palette displays 
the status of each Xref in the current drawing 
and the relation between the various Xrefs. It 
allows you to attach a new xref, detach, unload, 
load an existing one, change an attachment 
to an overlay, or an overlay to an attachment. 
You can also open a reference drawing 
for editing from this palette. Additionally, 
it allows you to edit an xref ’s path and 
bind the xref definition to the drawing. 

Apart from the methods mentioned in the 
command box, you can also invoke the 
External References palette by selecting 
an Xref in the current drawing and then 
right-clicking in the drawing area to display 
a shortcut menu. Next, choose External 
References from the shortcut menu; the 
External References palette is displayed. 

The upper right corner of the palette has two 
buttons: List View and Tree View.

List View
Choosing the List View button displays the xrefs present in the drawing in alphabetical order. 
This is the default view. The list view displays information about xrefs in the current drawing 
under the following headings:

Reference Name
This column lists the name of all existing references in the current drawing.

Status
This column lists the current status of each xref in the drawing. It lists whether an xref is loaded, 
unloaded, unreferenced, not found, orphaned, unresolved, or marked to be reloaded.  A loaded 
xref implies that the xref is attached to the current drawing. You can then unload it and then 
reload it using the options in the dialog box (this will be discussed later). An xref selected to be 
unloaded or reloaded displays Unload and Reload, respectively, under the Status column. If the 
xref has nested references that cannot be found, the status is Unreferenced, and if the parent 
of the nested reference gets unloaded, or cannot be found, its status is described as Orphaned. 
An unreferenced xref will not be displayed. If the xref is not found in the search paths defined, 
its status is Not Found. A missing xref or one that cannot be found is Unresolved.

Size
The file size of each xref is listed here.

Figure 16-3 The Palettes panel

Figure 16-4  The External References palette
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Type
This column lists whether the xref is an attachment or overlay.

Date
This column lists the date on which the xref drawing was last saved.

Saved Path
This column lists the path of the xref, that is, the route taken to locate the particular referenced 
drawing.

Choose any of these headings, sorts and lists the Xrefs in the current drawing according to that 
particular title. For example, on choosing Reference Name, the xrefs are sorted and listed as 
per the name. The column widths can be increased or decreased as per requirements. When 
you place your cursor at the edge of a column title button, the cursor changes to a horizontal 
resizing cursor. Now, press the pick button of your mouse and drag the column edge to increase 
or decrease its width. After you increase the column widths, it is possible that the width of the 
columns extend beyond the list box width. In such a case, a horizontal scroll bar appears at the 
bottom of the list box. You can use the scroll bar to view the columns that extend beyond the 
width of the list box.

On choosing the Tree View button available in the right side of the File References title bar, 
the xrefs are displayed in a hierarchical tree view in the External References palette. It displays 
information on nested xrefs and their relationship with one another. Xrefs are indicated by an icon 
of a paper with a paper clip. This icon appears with a cross mark when the xref gets unloaded, 
and if there is a missing xref, the”!” sign appears. Similarly, the upward arrow indicates that the 
xref was reloaded and the arrow pointing downward indicates that the xref is unloaded. You can 
also choose List View and Tree View by pressing the F3 and F4 keys, respectively. 

Attaching an Xref Drawing (Attach Option)
The Attach button is available at the upper left 
corner of the External References palette. If you 
choose the down arrow on this button, a flyout 
will be displayed. Select the Attach DWG option 
from the flyout to attach an xref drawing to the 
current drawing. This option can also be invoked 
by right-clicking on the File References area. The 
following examples illustrate the process of attaching 
an xref to the current drawing. In this example, it is 
assumed that there are two drawings, SHAFT and 
BEARING. SHAFT is the current drawing that is 
loaded on the screen (Figure 16-5) and the BEARING 
drawing is saved on the disk. If you want to xref the BEARING drawing in the SHAFT drawing, 
you need to follow the steps given below.

1.	 The first step is to make sure that the SHAFT drawing is on the screen (draw the shaft 
drawing with assumed dimensions). 

Tip
No drawing needs to be on the screen. You could attach both drawings, BEARING and SHAFT 
to an existing drawing, even if it is a blank drawing.

2. 	 Choose the External References Palette button from the Palettes panel to display the 
External References palette. In this palette, choose the Attach DWG button; the Select 
Reference File dialog box will be displayed.

Figure 16-5  Current drawing - SHAFT
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 	 Select the drawing that you want to attach (BEARING) and then choose the Open button; 
the Attach External Reference dialog box will be displayed on the screen (Figure 16-6). In 
the Attach External Reference dialog box (Figure 16-6), the name of the file that you have 
selected to be attached to the current drawing as an xref is displayed in the Name edit box. 
You can also specify the name of the file to be attached from the Name drop-down list.

Figure 16-6  The Attach External Reference dialog box

 Note
AutoCAD LT also searches for the xref file in the paths defined in the Project Files Search Path 
folder in the Files tab of the Options dialog box. This folder does not have any path defined in 
it and displays Empty when the tree view is expanded. To define a search path, select Empty 
and choose the Add button in the dialog box. You can enter a project name here, if you want. 
Now, expand the tree view, select Empty again and choose the Browse button; the Browse 
for Folder window is displayed. Select the folder that is to be searched for the file and choose 
OK. Then, choose Apply and OK in the Options dialog box to exit it.

	 In the Reference Type area, select the Attachment radio button, if it is not already selected 
(default option). The Overlay option is discussed later in this chapter. The Path type 
drop-down list is used to specify whether you want to attach a drawing with full path, relative 
path, or no path. If you select the Full path option, the precise location of the xreffed drawing 
is saved. If you select the Relative path option, the position of the xreffed drawing with 
reference to the host drawing is saved. If you select the No path option, AutoCAD LT will 
search for the xreffed drawing in only that folder in which the host drawing is saved. You 
can either specify the insertion point, scale factors, and rotation angle in the respective X, 
Y, Z, and Angle edit boxes or select the Specify On-screen check boxes to use the pointing 
device to specify them on the screen. By default, the scale factors in X, Y, and Z edit boxes is 
1 and the rotation angle is 0. The Block Unit area provides information regarding the units 
of the inserted block. The Unit edit box displays the unit of the block. The Factor edit box 
displays the scale factor, depending on the unit of the block and that of the current drawing. 
If you choose the Show Details button, the path of the file is displayed adjacent to Found in. 
Also, the saved path of the file is displayed adjacent to Saved path. Choose the OK button 

from the Attach External Reference dialog box to 
accept the default values and exit the dialog box. 
Specify the insertion point; the drawing is attached 
to the current drawing, but it appears faded. After 
attaching the BEARING drawing as an xref, save 
the current drawing with the file name SHAFT 
(Figure 16-7). You can control the fading intensity 
of the attached objects by using the options from the 
Fade Control area of the Display tab in the Options 
dialog box. In this area, you can either use the slider 
bar to increase or decrease the fading intensity or 
you can enter a value in the edit box. You can also 
use the XFADECTL variable to control the fading 
intensity of other objects while editing them. By default, the fading intensity value is set to 
50.

Note	
You can also use the -XREF command to attach a drawing from the pointer input. Except 
the Open option, all the options available in the External References palette are available 
through the dynamic preview too.

3.	 Open the BEARING drawing and make the changes shown in Figure 16-8 (draw polylines 
on the sides). Now, save the drawing with the file name BEARING.

4.	 Open the SHAFT drawing. In the External References palette, you will notice that the 
message Needs Reloading is displayed in the Status column of the BEARING drawing. 
Right-click on the BEARING and choose Reload; the modified BEARING drawing is 
automatically updated (Figure 16-9). This is the most useful feature of the XREF command. 
You could also have inserted the BEARING drawing as a block, but if you had updated the 
BEARING drawing, the drawing in which it was inserted would not have been updated 
automatically.

Figure 16-8  The modified xref 
BEARING drawing

Figure 16-9  BEARING drawing automatically updated after 
loading the SHAFT drawing

	 When you attach an xref drawing, AutoCAD LT remembers the name of the attached drawing. 
If you xref the drawing again, AutoCAD LT displays a message as given next.

Xref “BEARING” has already been defined.
Using existing definition.
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from the Attach External Reference dialog box to 
accept the default values and exit the dialog box. 
Specify the insertion point; the drawing is attached 
to the current drawing, but it appears faded. After 
attaching the BEARING drawing as an xref, save 
the current drawing with the file name SHAFT 
(Figure 16-7). You can control the fading intensity 
of the attached objects by using the options from the 
Fade Control area of the Display tab in the Options 
dialog box. In this area, you can either use the slider 
bar to increase or decrease the fading intensity or 
you can enter a value in the edit box. You can also 
use the XFADECTL variable to control the fading 
intensity of other objects while editing them. By default, the fading intensity value is set to 
50.

Note	
You can also use the -XREF command to attach a drawing from the pointer input. Except 
the Open option, all the options available in the External References palette are available 
through the dynamic preview too.

3.	 Open the BEARING drawing and make the changes shown in Figure 16-8 (draw polylines 
on the sides). Now, save the drawing with the file name BEARING.

4.	 Open the SHAFT drawing. In the External References palette, you will notice that the 
message Needs Reloading is displayed in the Status column of the BEARING drawing. 
Right-click on the BEARING and choose Reload; the modified BEARING drawing is 
automatically updated (Figure 16-9). This is the most useful feature of the XREF command. 
You could also have inserted the BEARING drawing as a block, but if you had updated the 
BEARING drawing, the drawing in which it was inserted would not have been updated 
automatically.

Figure 16-8  The modified xref 
BEARING drawing

Figure 16-9  BEARING drawing automatically updated after 
loading the SHAFT drawing

	 When you attach an xref drawing, AutoCAD LT remembers the name of the attached drawing. 
If you xref the drawing again, AutoCAD LT displays a message as given next.

Xref “BEARING” has already been defined.
Using existing definition.

Figure 16-7  Attaching the BEARING 
drawing as an xref 
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Specify insertion point or [Scale/X/Y/Z/Rotate/PScale/PX/PY/PZ/PRotate]: Specify the location 
to place another copy of the xref.

Note
If the xref drawing that you want to attach is currently being edited, AutoCAD LT will attach 
the drawing that was last saved through the SAVE, WBLOCK, or QUIT command.

Points to Remember about Xref
1.	 When you enter the name of the xref drawing, AutoCAD LT checks for block names and 

xref names. If a block exists with the same name as the name of the xref drawing in the 
current drawing, the XREF command is terminated and an error message is displayed.

2.	 When you xref a drawing, the objects that are in the model space are attached. Any objects 
that are in the paper space are not attached to the current drawing.

3.	 The layer 0, DEFPOINTS, and the linetype CONTINUOUS are treated differently. The 
current drawing layers 0, DEFPOINTS, and linetype CONTINUOUS will override the 
layers and linetypes of the xref drawing. For example, if the layer 0 of the current drawing 
is white and the layer 0 of the xref drawing is red, the white color will override the red.

4.	 The xref drawings can be nested. For example, if the BEARING drawing contains the 
reference INRACE and you xref the BEARING drawing to the current drawing, the INRACE 
drawing is automatically attached to the current drawing. If you detach the BEARING 
drawing, the INRACE drawing gets detached automatically.

5.	 You can rename an xref under the File References column name in the list box of the 
External References palette by highlighting the xref and then clicking on it again. You 
can now enter a new name. An AutoCAD LT warning is displayed: Caution! “XXXX” is 
an externally referenced block. Renaming it will also rename its dependent symbols.

 
6.	 When you xref a drawing, AutoCAD LT stores the name and path of the drawing by default. 

If the name of the xref drawing or the path where the drawing was originally stored has 
changed or you cannot find it in the path specified in the Options dialog box, AutoCAD 
LT cannot load the drawing, plot it, or use the Reload option of the xref command.

Detaching an Xref Drawing (Detach option)
The Detach option can be used to detach or remove the xref drawings. If there are any nested 
xref drawings defined with the xref drawings, they are also detached. Once a drawing is detached, 
it is erased from the screen. To detach an xref drawing, select the file name in the External 
References palette list box to highlight it and then right-click on it to select the Detach option. 
After selecting the Detach option, the xref is completely removed from the current drawing. 

You can also use the -XREF command to detach the xref drawings. When AutoCAD LT prompts 
for an xref file name to be detached, you can enter the name of one xref drawing or the name 
of several drawings separated by commas. You can also enter * (asterisk), in which case, all 
referenced drawings, including the nested drawings, will be detached.

Updating an Xref Drawing (Reload option)
When you load a drawing, AutoCAD LT automatically loads the referenced drawings. The 
Reload option of the XREF command lets you update the xref drawings and nested xref 
drawings at any time. You do not need to exit the drawing editor and then reload the drawing. 
To reload the xref drawings, invoke the External References palette, select the xreffed drawing 
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in the list box, and then right-click on it to choose the Reload option from the shortcut menu. 
AutoCAD LT will scan for the referenced drawings and the nested xref drawings and load the 
most recently saved version of the drawing.

You can reload all the attached xref drawings at one time by selecting Reload All References from 
the drop-down list of the Refresh button on the upper left corner of the External References 
palette. 

The Reload option is generally used when the xref drawings are currently being edited and you 
want to load the updated drawings. The xref drawings are updated based on what is saved on 
the disk. Therefore, before reloading an xref drawing, you should make sure that the xref draw-
ings that are being edited have been saved. If AutoCAD LT encounters an error while loading 
the referenced drawings, the XREF command is terminated, and the entire reload operation 
is canceled.

You can also reload the xref drawings by using the -XREF command. When you enter the -XREF 
command, AutoCAD LT will prompt you to enter an option. Enter R for the Reload option. 
Next, you are prompted to enter the name of the xref drawing. You can enter the name of one 
xref drawing or the names of several drawings separated by commas. If you enter * (asterisk), 
AutoCAD LT will reload all xref and nested xref drawings.

Unloading an Xref Drawing (Unload option)
The Unload option allows you to temporarily remove the definition of an xref drawing from 
the current drawing. However, AutoCAD LT retains the pointer to the xref drawings. When you 
unload the xref drawings, the drawings are not displayed on the screen. You can reload the xref 
drawings by using the Reload option. 

Tip
It is recommended that you unload the referenced drawings if they are not being used. After 
unloading the xref drawings, the drawings load much faster and need lesser memory.

Adding an Xref Drawing (Bind option)
The Bind option lets you convert the xref drawings to blocks in the current drawing. The bound 
drawings, including the nested xref drawings (that are no longer xrefs), become a permanent 
part of the current drawing. The bound drawing cannot be detached or reloaded. You can use 
this option when you want to send a copy of your drawing to a customer for review. Because the 
xref drawings are a part of the existing drawing, you do not need to include the xref drawings or 
the path information. You can also use this option to 
safeguard the master drawing from accidental editing 
of the piece parts. To bind the xref drawings, select 
the file names in the External References palette 
and then right-click and choose the Bind option 
from the shortcut menu; the Bind Xrefs dialog box 
(Figure 16-10) is displayed. AutoCAD LT provides two 
methods to bind the xref drawing in the Bind Type area 
of the dialog box. These methods are discussed next.

Bind
When you use the Bind radio button, AutoCAD LT binds the selected xref definition to the 
current drawing. All the xrefs are converted to blocks and the named objects are renamed. 
For example, if you xref the drawing Bearing with a layer named Object, a new layer 
Bearing|Object is created in the current drawing. When you bind this drawing, the xref 
dependent layer Bearing|Object will become a locally defined layer Bearing$0$Object 

Figure 16-10  The Bind Xrefs dialog box
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(Figure 16-11). If the Bearing$0$Object layer already exits, AutoCAD LT will automatically 
increment the number, and the layer name becomes Bearing$1$Object.

Figure 16-11  Partial view of the Layer Properties Manager dialog box

Insert
When you use the Insert option, AutoCAD LT inserts the xref drawing. The xrefs get converted 
into blocks. For example, if you xref the drawing SHAFT with a layer named Object, a new 
layer SHAFT|Object is created in the current drawing. If you use the Insert option to bind 
the xref drawing, the layer name SHAFT|Object is renamed as Object. If the object layer 
already exists, then the values set in the current drawing override the values of the inserted 
drawing. 

Note
It is possible to bind only an individual or several xref-dependent named objects instead of the 
entire drawing into the current drawing. This will be discussed later in this chapter.

You can also use the -XREF command to bind the xref drawings. In such cases, prompts are 
displayed on the Command prompt.

Editing an XREF’s Path
By default, AutoCAD LT saves the path of the referenced drawing and displays it in the Saved Path 
column in the External References palette. As mentioned earlier, when AutoCAD LT loads the 
drawing containing a referenced file, and if it is not able to find the file at the location specified in 
the Saved Path column of the External References palette, it searches for the file in the current 
directory, and in the Support File Search Path locations specified in the Files tab of the Options 
dialog box. If a file with the same name is found here, it is loaded. Now, when you invoke the 
External References palette, you will notice that when you select an xref name in the list box 
to highlight it, the path displayed in the Saved Path column for the xref file is different from 
the one displayed in the Found At edit box. To update the path of the xref file, choose the Save 
Path button. The new path is saved and displayed in the Saved Path column.

If AutoCAD LT cannot locate the specified file even in the directories specified in the Files 
tab of the Options dialog box, it will display an error message saying that it cannot find the 
specified file. The path of the file is displayed as a marker text in the current drawing. Now, when 
you invoke the External References palette, the status of the drawing is shown as Not Found. To 
specify a new path for the xref file, select the xref file name in the list box of the dialog box and 
choose the Browse button. The Select new path dialog box is displayed where you can locate 
the drawing to be used as xref. Once you have found the file, choose the Open button to return 
to the External References palette. The new path is displayed in the Saved Path column and 
the Found At edit box. The specified xref file is reloaded and replaces the marker text in the 
drawing, when you choose the OK button in the External References palette. If you remember 
the new location of the xref file, you can also enter it in the Found At edit box. For example, if 
a drawing, which was originally in the C:\CAD\Proj1 subdirectory, has been moved to A:\Parts 
directory, the path must be edited so that AutoCAD LT is able to load the xref drawing.
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The Overlay Option
As discussed earlier, when you attach an xref to a drawing, the Attach External References dialog 
box is displayed. The Reference Type area of this dialog box has two radio buttons, Attachment 
and Overlay. You can select any of these radio buttons to xref a drawing. The Attachment radio 
button is selected by default. The advantage of selecting the Overlay radio button is that you 
can access the desired drawing instead of the drawing along with its xreffed attachments. For 
example, consider three people working on three different drawings that are a part of the same 
project. The first designer is working on the layout of walls of a room, the second designer 
is working on the furniture layout of the room, and the third on the electrical layout of that 
room. The names of the drawings are WALLS, FURNITURE, and ELECTRICAL, respectively. 
Assume that the designer working on the walls layout selects the Attachment radio button to 
xref the FURNITURE drawing so that he or she can check the furniture layout according to 
the wall structure. After insertion, the WALLS drawing will comprise the wall structure (current 
drawing) along with the furniture layout (xreffed drawing). Now, if the designer working on the 
electrical layout xrefs the WALLS drawing to check the location of electrical fittings with respect 
to the walls, he/she will get the drawing that has the furniture layout as well as the wall layout. 
This is because the FURNITURE drawing was xreffed in the WALLS drawing by selecting the 
Attachment radio button.

In the above example, the designer working on the ELECTRICAL drawing may not require 
the FURNITURE drawing. This is because at this stage, he/she is more interested in checking 
the electrical fittings with respect to the wall structure. So the furniture layout that is xreffed 
with the wall structure needs to be avoided. This can be done by selecting the Overlay radio 
button while X-referencing the FURNITURE drawing in the WALLS drawing. This means that 
the designer working on the wall structure needs to xref the furniture layout by selecting the 
Overlay radio button. Now, if the wall structure is xreffed in some other drawing, the furniture 
layout will not appear.

One of the problems of using the Attachment option 
is that you cannot have a circular reference. For 
example, assume you are designing the plant layout 
of a manufacturing unit. One person is working on 
the floor plan (see Figure 16-12), and the second 
person is working on the furniture layout in the 
offices (Figure 16-13). The names of the drawings are 
FLOORPLN and OFFICES, respectively. The person 
working on the office layout uses the Attachment 
option to insert the FLOORPLN drawing so that he 
or she has the latest floor plan drawing. The person 
who is working on the floor plan wants to reference 
the OFFICES drawing. 

Now, if the Attachment option is used to reference the drawings, AutoCAD LT displays an error 
message. This is because by attaching the OFFICES drawing, a circular reference is created. The   
AutoCAD LT message displayed is “Circular references detected. Continue?” (Figure 16-14). If 
you choose the No button, the XREF command is canceled and no drawing is referenced. But if 
you choose the Yes button, the following message is displayed Breaking circular reference from 
“offices” to “current drawing” and the particular file you wanted to reference is referenced.

However, to overcome this problem of circular reference, you can use the Overlay option to 
overlay the OFFICES drawing. This is a very useful option because the Overlay option lets 
different operators avoid circular reference and share the drawing data without affecting the 

Figure 16-12  Hierarchy of FLOORPLAN 
drawing
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Figure 16-14  The AutoCAD LT 
Alert message box

Figure 16-13  Hierarchy of OFFICES drawing  

drawing. Overlaying allows you to view a referenced drawing without having to attach it to the 
current drawing. This option can be invoked by selecting the Overlay radio button in the Attach 
External References dialog box, which is displayed after you have selected a drawing to reference. 
Also, when a drawing that has a nested overlay is overlaid, the nested overlay is not visible in the 
current drawing. This is another difference between attaching an xref and overlaying an xref to 
a drawing. This feature is especially useful when you want to reference a drawing that another 
user who is referencing your drawing does not need. Although the attachment will reference 
the nested reference too, the overlay option ignores nested references.

Example 1 				        Attachment and Overlay
In this example, you will use the Attachment and Overlay options to attach and reference the 
drawings. Two drawings, PLAN and PLANFORG are given. The PLAN drawing (Figure 16-15) 
consists of the floor plan layout, and the PLANFORG drawing (Figure 16-16) has the details of 
the forging section only. The CAD operator who is working on the PLANFORG drawing wants 
to xref the PLAN drawing for reference. Also, the CAD operator working on the PLAN drawing 
should be able to xref the PLANFORG drawing to complete the project. The following steps 
illustrate how to accomplish the defined task without creating a circular reference.

Figure 16-15  The PLAN drawing Figure 16-16  The PLANFORG drawing
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How circular reference is caused?

1.	 Open the drawing PLANFORG, and then choose the External References tool from the 
Palettes panel in the View tab. Next, choose the Attach DWG button from the External 
References palette; the Select Reference File dialog box is displayed. Select the PLAN 
drawing from the list box of the Select Reference File dialog box and choose the Open 
button; the Attach External Reference dialog box is displayed. In this dialog box, the name 
of the PLAN drawing is displayed in the Name edit box, and the Attachment radio button 
is selected by default in the Reference Type area. Choose OK to exit the dialog box and 
specify an insertion point on the screen. Now, the drawing consists of the PLANFORG and 
PLAN. Save the drawing.

2.	 Open the drawing file PLAN. Next, choose the External References Palette button and 
attach the PLANFORG drawing to the PLAN drawing using the same steps as described in 
Step 1. AutoCAD LT will display the message that the circular reference has been detected 
and will ask you if you want to continue. If you choose Yes in the AutoCAD LT message box, 
the circular reference is broken and you are allowed to reference the specific drawing.

	 The possible solution for the operator working on the PLANFORG drawing is to detach 
the PLAN drawing. This way the PLANFORG drawing does not contain any reference to 
the PLAN drawing and would not cause any circular reference. The other solution is to use 
the Overlay option, as follows :

How to prevent circular reference?

3.	 Open the PLANFORG drawing (Figure 16-17) and select the Overlay radio button in the 
Attach External References dialog box, which is displayed after you have selected the 
PLAN drawing to reference. The PLAN drawing is overlaid on the PLANFORG drawing 
(Figure 16-18).

Figure 16-17  The PLANFORG drawing Figure 16-18  The PLANFORG drawing after 
overlaying the PLAN drawing

4.	 Open the drawing file PLAN (Figure 16-19), and select the Attachment radio button in  the 
Attach External Reference dialog box, which is displayed when you select the PLANFORG 
drawing in the Select Reference File dialog box to attach it as an xref to the PLAN drawing. 
You will notice that only the PLANFORG drawing is attached (Figure 16-20). The drawing 
that was overlaid in the PLANFORG drawing (PLAN) does not appear in the current drawing. 
This way, the CAD operator working on the PLANFORG drawing can overlay the PLAN 
drawing, and the CAD operator working on the PLAN drawing can attach the PLANFORG 
drawing, without causing a circular reference.
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Figure 16-19  The PLAN drawing Figure 16-20  The PLAN drawing after attaching 
the PLANFORG drawing

Attaching Files to a Drawing
  Ribbon:  Insert > Reference > Attach		  Command: ATTACH 	

You can use the Attach tool in the Reference panel (Figure 16-21) to attach a DWG, DGN, 
DWF, PDF, or image file without invoking the External References palette. Using this tool, 
you can attach a drawing file easily, since most of the xref operations involve simply attaching a 
drawing file. When you invoke this tool, AutoCAD LT displays the Select Reference File dialog 
box. To attach a .dwg, .dgn, .pcg, .isd, .dwf, .pdf, or image 
file, specify it in the Files of type drop-down list in the 
Select Reference dialog box; the corresponding files 
will be listed in the dialog box. Select the drawing file 
to be attached and choose the Open button; the Attach 
External Reference dialog box is displayed. Select the 
Attachment radio button under the Reference Type area. 
You can specify the insertion point, scale, and rotation 
angle on screen or in the respective edit boxes. 

Tip
When you attach or reference a drawing that has a drawing order created by using the 
DRAWORDER command, the drawing order is not maintained in the xref. To maintain the 
drawing order, first open the xref drawing and specify the drawing order in it. Now, use the 
WBLOCK command to convert it into a drawing file and the XATTACH command to attach 
the newly created drawing file to the current drawing. In this way, the drawing order will be 
maintained. 

Note
To select a .dgn, .dwf, .pdf, or image file, specify the file type in the Files of type drop-down list 
in the Select Reference File dialog box; the files will be attached as an underlay. Underlays are 
discussed in the next section.

AutoCAD LT maintains a log file (.xlg) for xref drawings if the XREFCTL system variable is set 
to 1. This file lists information about the date and time of loading and other xref operations to be 
completed. This .xlg file is saved in the current drawing with the same name as the current 
drawing and is updated each time the drawing is loaded or any xref operations are carried out.

Figure 16-21  The Attach tool in the 
Reference panel
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Working with Underlays
You can attach a DWF, DGN, or PDF file as an underlay to the current drawing file. The underlay 
files are not a part of original drawing files. Therefore, if you add a file as an underlay, it does 
not increase the file size of the current drawing. The procedure to add a file as an underlay is 
similar to attaching a drawing file using the Attach tool. After you select the file to attach, the 
Attach <XXXX> Underlay dialog box will be displayed, where <XXXX> is the file type. 
Figure 16-22 shows the Attach PDF Underlay dialog box that is displayed on selecting a pdf 
file from the Select Reference File dialog box.

Figure 16-22  The Attach PDF Underlay dialog box

If the selected .pdf file has multiple pages, all pages of the pdf file are listed in the Select one or 
more pages from the PDF file area. Select the pages to be attached from this area. If you have 
selected multiple pages as well as the Specify on-screen check box from the Insertion point 
area, then you are prompted to specify different insertion points for different pages. 

The files attached as an underlay behave like blocks. The general modify commands like move, 
copy, rotate, mirror, and so on can be applied on them. However, you cannot bind a file that is 
attached as an underlay or modify the attached file in the current drawing file.

Editing an Underlay
As discussed earlier, you cannot edit a file that is attached as an underlay. However, you can 
control the appearance of the underlay by adjusting the contrast, fade, and monochrome display. 
To do so, select the attached object; a contextual tab will be displayed. Figure 16-23 shows the 
DGN Underlay tab that is displayed on selecting a DGN file. 

Figure 16-23  The DGN Underlay tab
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You can use the options in this contextual tab to adjust the fade, contrast, and monochrome 
display of the underlay. You can create a new clipping boundary similar to that of an attached 
drawing. By default, the Enable Snap button is chosen in the Options panel. Therefore, you 
can snap entities in the underlaid object. If you deselect this button, you cannot snap entities 
in the underlaid objects. You can use the Show Underlay button from the Options panel to 
display/hide the underlaid objects. Both Enable Snap and Show Underlay are toggle buttons. If 
the attached underlay has layers, you can hide/display the selected layers. To do so, choose the 
Edit Layers button from the contextual tab; the Underlay Layers dialog box will be displayed, 
as shown in Figure 16-24. If multiple drawings are attached as an underlay, all file names will 
be listed in the Reference Name drop-down list. Select the file from the Reference Name 
drop-down list for which you need to hide the layers; the corresponding layers will be listed in 
the list box. Click on the bulb icon of the layer to be hidden. Alternatively, select the layer from 
the list box and right-click; a shortcut menu will be displayed. Choose the Layer(s) Off option 
to hide the selected layer. To hide multiple layers, press the CTRL key and select the layers to 
be hidden. Next, choose Layer(s) Off. Then, press ESC to exit the editing mode; the contextual 
tab will disappear.

Figure 16-24  The Underlay Layers dialog box

If you have attached a file as an underlay, you can invoke the Underlay Layers dialog box without 
invoking the contextual tab by choosing the Underlay Layers tool from the Reference panel 
in the Insert tab. Similarly, you can switch on/off the OSNAP settings for the drawing that are 
underlaid by choosing the Snap to Underlays ON / Snap to Underlays OFF button respectively 
from the Snap to Underlays drop-down in the Reference panel. 

Note
If there are more underlays of different file types and you have set different osnap setting for each 
file type, then the Underlay Osnaps Vary button will be displayed in the Snap to Underlays 
drop-down in the Reference panel. However, if you choose the Snap to Underlays ON / Snap 
to Underlays OFF button, the corresponding osnap setting will be applied to all underlays.
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Opening an Xreffed Object in a Separate 
Window
If you are in the host drawing and you want to open a selected xreffed object in a separate 
window without using the Select File dialog box, you can use the XOPEN command. When 
you invoke this command, you are prompted to select the xref. Select the xreffed object that 
you want to open in a separate window. When you select the desired xref, AutoCAD LT opens 
the DWG file of the xreffed object in a separate window. You can now make the desired changes 
in the DWG file of the xreffed object. Save the changes and then close the drawing. When you 
open the host drawing, you will notice that the Communication Center displays a message that 
the external reference file has changed and the xreffed drawing needs to be reloaded. Reload 
the xreffed drawing using the External References palette and you will notice that the host 
drawing is updated.

Using the DesignCenter to attach a drawing as 
an Xref
The DesignCenter can also be used to attach an xref to a drawing. To do so, choose the 
DesignCenter button from the Palettes panel in the View tab; the DesignCenter will be displayed. 
In the DesignCenter, choose the Tree View Toggle button, if it is not chosen already, to display 
the tree pane. Expand the Tree view and double-click on the folder whose contents you want 
to view. The contents of the selected folder are displayed in the palette. From the thumbnails 
of drawings displayed on the right-side of the palette, right-click on the drawing to be attached 
as an xref; a shortcut menu is displayed, refer to Figure 16-25. Choose Attach as Xref from 
the shortcut menu; the Attach External Reference dialog box will be displayed. Alternatively, 
you can also use the right or left mouse button to drag and drop the drawing into the current 
drawing; a shortcut menu will be displayed again. Choose Attach as Xref; the Attach External 
Reference dialog box will be displayed. 

Figure 16-25  The DesignCenter

In this dialog box, the Name edit box displays the name of the selected file to be inserted as 
an xref. Select the Attachment radio button in the Reference type area, if not already selected. 
Specify the Insertion point, Scale, and Rotation in the respective edit boxes or select the Specify 
On-screen check boxes to specify this information on the screen. Choose OK to exit the dialog 
box; the selected object is attached as an xref to the current drawing.
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Adding xref Dependent named objects
  Menu Bar:  Modify > Object > External Reference > Bind	  
  Toolbar: Reference > Xbind		       Command:  XBIND  	

You can use the Xbind tool (Figure 16-26) to add the selected named objects such as blocks, 
dimension styles, layers, line types, and text styles of the xref 
drawing to the current drawing. The following example describes 
the use of this command.

1.	 Load the drawing Bearing that was created earlier when the 
Attach option of the XREF command was discussed. Make 
sure the drawing has the following layer setup. Otherwise, 
create the following layers using the Layer Properties 
Manager dialog box.

Layer Name	             Color	 Linetype	

	 0			   White		  Continuous

	 Object		  Red		  Continuous

	 Hidden		  Blue		  Hidden2

	 Center		  White		  Center2

	 Hatch		  Green		  Continuous

2.	 Draw a circle and create it as a block with the name SIDE. Save the drawing as BEARING.

3.	 Start a new drawing with the following layer setup:

Layer Name	            Color	 Linetype	

	 0			   White		  Continuous

	 Object		  Red		  Continuous

	 Hidden		  Green		  Hidden

4.	 Use the XAttach tool in the Reference panel or the Attach option of the XREF command 
to attach the Bearing drawing to the current drawing. When you xref the drawing, the layers 
will be added to the current drawing, as discussed earlier in this chapter.

5.	 Now, invoke the Xbind tool; the Xbind dialog box is displayed. This dialog box has two 
areas with list boxes. They are Xrefs and Definitions to Bind. If you want to bind the blocks 
defined in the xref drawing Bearing, first click on the plus sign adjacent to the xref Bearing. 
Icons for the named objects in the drawing are displayed in a tree view (Figure 16-27). 
Click on the plus sign next to the Block icon. AutoCAD LT lists the blocks defined in the 
xref drawing (Bearing). Select the block Bearing|Side and then choose the Add button. 
The block name will be added to the Definitions to Bind list box. Choose OK to exit the 
dialog box. AutoCAD LT will bind the block with the current drawing and a message is 
displayed at the Command prompt: 1 Block(s) bound. The name of the block will change 
to Bearing$0$SIDE. You can invoke the Block Definition dialog box by choosing the Create 
Block tool in the Block Definition panel and check the Name drop-down list to see if the 
block with the name Bearing$0$SIDE has been added to the drawing. If you want to insert 
the block, you must enter the new block name (Bearing$0$SIDE). You can also rename the 
block to another name that is easier to use.

 	 If the block contains a reference to another xref drawing, AutoCAD LT binds that xref 
drawing and all its dependent symbols to the current drawing also. Once you XBIND the 

Figure 16-26  The Xbind tool 
in the Reference toolbar
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dependent symbols, AutoCAD LT does not delete them, not even when the xref drawing 
is detached. For example, the block Bearing$0$SIDE will not be deleted even when you 
detach the xref drawing or end the drawing session.

Figure 16-27 The Xbind dialog box

	 You can also use the -XBIND command to bind the selected dependent symbols of the xref 
drawing using the Command prompt.

6.	 Similarly, you can bind the dependent symbols, Bearing|Standard (textstyle), 
Bearing|Hidden, and Bearing|Object layers of the xref drawing. Click on the plus signs 
adjacent to the respective icons to display the contents and then select the layer or textstyle 
you want to bind and choose the Add button. The selected named objects are displayed in 
the Definitions to Bind list box. If you have selected a named object that you do not want 
to bind, select it in the Definitions to Bind list box and choose the Remove button. Once 
you have finished selecting the named objects that you want to bind to the current drawing, 
choose OK. A message indicating the number of named objects that are bound to the current 
drawing is displayed at the Command prompt.

	 Once bound, the layer names will change to Bearing$0$Hidden and Bearing$0$Object. If the 
layer name Bearing$0$Hidden was already there, the layer will be named Bearing$1$Hidden. 
These two layers become a permanent part of the current drawing. Even if the xref drawing 
is detached or the current drawing session is closed, the layers are not discarded. 

Clipping External References
  Ribbon: Insert > Reference > Clip 		  Command: CLIP  

The Clip tool (Figure 16-28) is used to trim an xref after it has been attached to a drawing 
to display only a portion of the drawing (Figure 16-29). After you have attached an xref to 
a drawing, you can trim it to display only a portion of the drawing by using the Clip tool. 
However, clipping xref does not, in any way, modify the referenced drawing. On invoking 
the Clip tool, you are prompted to select an object to clip. Select a DWG, DGN, IMAGE, 
or PDF; the respective clipping options will be displayed. You can also invoke the Clip tool 

Figure 16-28  The Clip tool in the 
Reference panel

Figure 16-29  Using the CLIP command 
to clip 
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by selecting an xref and then right-clicking in the drawing area to display a shortcut menu. 
Next, choose the corresponding clip command from it. For example, to clip an attached .dwg 
file, select the attached .dwg file, right-click, and choose the CLIP Xref option; the following 
prompt sequence will be displayed.

Command: _XCLIP 1 found
Select objects: Select the xref that needs to be clipped.
Select objects: Press ENTER
Enter clipping option
[ON/OFF/Clipdepth/Delete/generate Polyline/New boundary] <New>: Press Enter to 
specify a new clip boundary or enter an option.
[Select polyline/Polygonal/Rectangular/Invert clip] <Rectangular>: Press Enter to select the 
Rectangular option, and then specify two corners of the rectangular boundary.

You can also right-click in the drawing area at the Enter clipping option prompt to display a 
shortcut menu. This shortcut menu displays all the options available at the Command prompt 
that can be selected here. All the clipping options available are discussed next. 

New boundary
The clipping boundary can be specified by using the Rectangular, Polygonal, or Select polyline 
option. The Rectangular option generates a rectangular boundary and the Polygonal option 
allows you to specify a boundary of any shape. You can draw a boundary using the Polyline 
tool or the Polygon tool and then, use the Select polyline option to select this polyline as the 
clipping boundary. The Invert clip option inverts the direction of the clipping. For example, 
if the objects outside the clipping boundary are hidden, by default, the Invert clip option will 
hide the objects inside the clipping boundary and display the objects outside the boundary. After 
selecting the Invert clip option, you need to redefine the clipping boundary using any one of 
the options discussed above. The Invert clip option can only be used with the 2D Wireframe 
visual style. If a boundary already exists, AutoCAD LT will ask you if the old boundary should 
be deleted. You can enter YES if you want to delete the old boundary and define a new one. If 
you enter NO, the old boundary is retained and the XCLIP command ends.

ON/OFF
The ON/OFF option allows you to specify whether to display the clipped portion or not. When 
the clipping boundary is off, you can see the complete xref drawing and when it is on, the 
drawing that is within the clipping polygon is displayed.

Delete
The Delete option completely deletes the predefined clipping boundary and the entire xref gets 
displayed. The Erase tool cannot be used to delete the clipping boundary.

generate Polyline
If you have a clipped boundary, select this option to create a polyline coinciding with the 
boundary of the clipped xref drawing. You can edit the polyline boundary without affecting the 
clipped drawing. For example, if you stretch the boundary, it does not affect the xref drawing. 
The edited boundary can be used later to specify a new clipping boundary.

Note
Polyline generated using the generate Polyline option of the XCLIP command should not be 
confused with the clipping boundary. Although both coincide with each other, you can select and 
edit only the polyline. When you select the clipping boundary, the xref object is also selected.
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Clipdepth
This option allows you to define the front and back clipping planes for xref objects or blocks. 
The objects between the front and back planes will be displayed (Figures 16-30 and 16-31). 
You will be able to understand this option better after you have dealt with drawings later in the 
book. In the figures that follow, the clipping boundary is defined aligned to the front face of the 
object, and therefore, the clipping planes will get defined parallel to it. The xref must contain a 
clip boundary before specifying a clip depth. If you use the Clipdepth option, it prompts you to 
specify a front clip point and a back clip point. Specifying these points, creates a clipping frame 
passing through them and parallel to the clipping boundary. If the front clipping plane is specified 
behind the back clipping plane, AutoCAD LT displays an error message and the clipdepth is also 
not applied. The Distance option for specifying the front or back clip points creates a clipping 
plane at a specified distance from the clipping boundary parallel to it. The Remove option 
removes both the front and back clipping planes and the entire object is visible.

Figure 16-30  Xref object before clipping Figure 16-31  Xref object after clipping

Similarly, you can clip the other underlaid xrefs. The options available for clipping the 
underlaid Xrefs are ON, OFF, Delete, and New Boundary. These options are the same as 
discussed above.

Displaying Clipping Frame
You can use the FRAME system variable to turn on or off the 
display of clipping boundary of all clipped Xrefs. When the value 
of FRAME system variable is 0 (default), the clipping boundary 
will not be displayed. When it is 1, the clipping boundary will be 
displayed and plotted. When it is 2, the clipping boundary will 
be displayed, but not plotted. To control the display of frames 
of individual attached Xrefs, you need to invoke the individual 
system variables like XCLIPFRAME, DGNFRAME, PDFFRAME, 
and IMAGEFRAME. Alternatively, choose the appropriate option 
from the Frames drop-down list in the Reference panel of the 
Insert tab (Figure 16-32). If there are multiple underlays of 
different file types and you have set different frame settings for 
each file type, then the Frames Vary button will be displayed in 
the Reference panel of the Insert tab.

Demand Loading
The demand loading feature loads only that part of the referenced drawing that is required in 
the existing drawing. For example, demand loading provides a mechanism by which objects 
on frozen layers are not loaded. Also, only the clipped portion of the referenced drawing can 

Figure 16-32  Options in the 
Frame drop-down list
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be loaded. This makes the xref operation more efficient since less disk space is used, especially 
when the drawing is reopened. Demand loading is enabled by default. You can modify its settings 
in the External References (Xrefs) area of the Open and Save tab of the Options dialog box 
(Figure 16-33). You can select any of the three settings available in the Demand load Xrefs 
drop-down list in this dialog box. They are Disabled, Enabled, and Enabled with copy. These 
options correspond to a value of 0, 1, and 2 of the XLOADCTL system variable, respectively, 
and are discussed next.

Setting	 Value of XLOADCTL		  Features			    

	 Disabled		     0		  1. Turns off demand loading.

						      2. Loads entire xref drawing file.

						      3. The file is available on the server and other users 	
				         		       can edit the xref drawing.

	 Enabled		     1		  1. Turns on demand loading.

						      2. The referenced file is kept open.

						      3. Makes the referenced file read-only for other  
						           users.

	 Enabled with copy	    2		  1. Turns on demand loading with the copy option.

						      2.  A copy of a referenced drawing is opened.

						      3. Other users can access and edit the original  
					         	       referenced drawing file.

Figure 16-33  Partial view of the Open and Save tab of the Options dialog box

You can also set the value of XLOADCTL at the Command prompt. When you are using the 
Enabled with copy option of demand loading, the temporary copies of the xref are saved in 
the AutoCAD LT temporary files directory (defined in the Temporary External Reference File 
Location folder in the Files tab of the Options dialog box) or in a user-specified directory. The 
XLOADPATH system variable creates a temporary path to store demand loaded Xrefs.
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Spatial and Layer Indexes
As mentioned earlier, the demand loading improves performance when the drawing contains 
referenced files. To make it work effectively and to take full advantage of demand loading, you 
must store a drawing with Layer and Spatial indexes. The layer index maintains a list of objects in 
different layers and the spatial index contains lists of objects based on their location in space. 

Layer and spatial indexes are created using the Save Drawing As dialog box. Choose the Tools 
button available on the upper right corner of the dialog box to display a shortcut menu. Choose 
the Options option from the shortcut menu to display the Saveas Options dialog box. Choose 
the DWG Options tab if it is not already chosen and select the type of index you want to save the 
file with from the Index type drop-down list. None is the default option, that is, no indexes are 
created. The other options available are: Layer, Spatial, and Layer & Spatial.  Once you have 
selected the type of index to create, choose the OK button to exit the dialog box and choose 
the Save button in the Save Drawing As dialog box to save the drawing with the indexes. The 
INDEXCTL variable also controls the creation of layer index and spatial index and its value can 
be set using the Command prompt. The following are the settings of the INDEXCTL system 
variable, and they correspond to the Index type options available in the DWG Options tab of 
the Save Options dialog box.

Setting	 Features		  Index Type option	

	 0		  No index created			   None		

	 1		  Layer index created			   Layer

	 2		  Spatial index created			   Spatial

	 3		  Layer and spatial index created		  Layer and Spatial

Editing References in-Place
  Ribbon:  Insert > Reference > Edit Reference		  Command:  REFEDIT	  
  Toolbar: Refedit > Edit Reference In-Place					   

Often you have to make minor changes in the xref drawing if you want to save yourself from the 
trouble of going back and forth between drawings. In this situation, you can use in-place reference 
editing to select the xref, modify it, and then save it after modifications. This feature of AutoCAD LT 
has already been discussed in detail with reference to blocks in Chapter 14, Working with Blocks. 
The following steps explain the referencing editing process.

1.	 To edit in-place, select an external referenced object; the Edit Reference drop-down will 
be added to the Ribbon. Choose the Edit Reference In-Place tool from the Edit panel; the 
Reference Edit dialog box will be displayed. After selecting the external referenced object, 
you can also invoke the shortcut menu and choose the Edit Xref In-place option from it to 
invoke the Reference Edit dialog box.

2.	 In the Reference name list box of the Reference Edit dialog box, the selected reference 
and its nested references are listed. Select the specific xref you wish to edit from the list. 

3.	 In the Settings tab of the dialog box, select both the Create unique layer, style, and 
block names and the Lock objects not in working set check boxes. The Display attribute 
definitions for editing check box is disabled by default. In the Identify Reference tab of 
the dialog box, select the Prompt to select nested objects radio button. Choose OK to 
return to the current drawing. At the Select nested objects: prompt, select the objects you 
want to modify and press ENTER. The Edit Reference drop-down is added to the Ribbon 
(Figure 16-34), and the objects that have not been selected for modifications become faded. 
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The fading is controlled by the XFADECTL system variable or by using the Xref display 
slider bar in the Display tab of the Options dialog box. You can add or remove objects to 
the working set by choosing the respective tools in the Edit Reference drop-down in the 
Insert tab or by using the REFSET command. Once you have defined a working set, all the 
standard AutoCAD LT commands can be used to modify them.

Figure 16-34  The Edit Reference drop-down added to the Ribbon

4.	 When you choose the Save Changes tool in the Edit Reference drop-down, AutoCAD LT 
displays a message: All reference edits will be saved. Choose OK to return to the drawing 
area. The modifications made are saved in the drawing as well as in the current drawing as 
a reference. On choosing the Discard Changes button in the Edit Reference drop-down, 
the changes made will not be saved and the current drawing is redisplayed.  

Note
In the External References (Xrefs) area of the Open and Save tab of the Options dialog 
box, if you select the Allow other users to Refedit current drawing check box, the current 
drawing can be edited in-place by other users even when it is open and is being referenced by 
another file. This option is selected by default and can also be controlled by the XEDIT system 
variable. The default value of XEDIT is 1 and can be changed using the Command prompt.

 Self-Evaluation Test	
Answer the following questions and then compare them to those given at the end of this 
chapter:

1.	 If an assembly drawing has been created by inserting a drawing, the drawing will be updated 
automatically if a change is made the drawing inserted. (T/F) 

2.	 The external reference facility helps you keep a drawing updated no matter when the changes 
were made in the piece part drawings. (T/F) 

3.	 Objects can be added to a dependent layer. (T/F) 

4.	 While referencing a drawing, if you use the Attachment option, the drawing will reference 
the nested references too, while the Overlay option ignores the nested references. (T/F).

5.	 The __________ are entries such as blocks, layers, and text styles.

6.	 If you use the Insert tool to insert a drawing, the information about the named objects is 
lost if the names are ____________, and if the names are ___________, the drawing will be 
imported.

7.	 The ___________ button of the External References palette is used to attach an xref drawing 
to the current drawing.

8.	 The ________________ feature loads only that part of the referenced drawing that is required 
in the existing drawing. 
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9.	 The _________ option can be used to overcome the problem of circular reference. 

10.	 If the Retain changes to Xref layers  check box is  __________ in the External References 
(Xrefs) area of the Open and Save tab of the Options dialog box, the layer settings such as 
color, linetype, on/off, and freeze/thaw are retained. The settings are saved with the drawing 
and are used when you xref the drawing the next time.

 Review Questions  
Answer the following questions:

1.	 If the xref drawings get updated, changes are not automatically reflected in the assembly 
drawing when you open an assembly drawing. (T/F)  

2.	 There is a limit to the number of drawings you can reference. (T/F)

3.	 It is not possible to have nested references. (T/F) 

4.	 Like blocks, the xref drawings can be scaled, rotated, or positioned at any desired location. 
(T/F)

5.	 You can change the color, linetype, or visibility (on/off, freeze/thaw) of a dependent layer. 
(T/F)

6. 	 Which of the following features lets you reference an external drawing without making this 
drawing a permanent part of the existing drawing?

	       (a) demand loading		  (b) external reference
		  (c) external clipping		  (d) insert drawing

7.	 If an xref has nested references that cannot be found, which of the following will be displayed 
under the status heading of the List View button in the External References palette?

 
		  (a) Orphaned			   (b) Not found
	 (c) Unreferenced		  (d) Unresolved

8.	 Which of the following commands can be used from the Command prompt to attach a 
drawing?

		  (a) -XBIND			   (b) -XREF
		  (c) XCLIP 			    (d) None of these

9.	 Which of the following system variables, when set to 1, will allow AutoCAD LT to maintain 
a log file (.xlg) for xref drawings?

		  (a) XLOADCTL		  (b) XLOADPATH
	 	 (c) XREFCTL 			   (d) INDEXCTL	
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10.	 Which of the following system variables, when set to 0, will not allow the clipping boundary 
to be displayed?

		  (a) FRAME	 		  (b) XLOADCTL
		  (c) INDEXCTL			  (d) XREFCTL	 	
		
11.	 In the __________ drawings, the information regarding dependent symbols is not lost.

12.	 AutoCAD LT maintains a log file for xref drawings, if the __________ variable is set to 1.

13.	 It is possible to edit xrefs in-place using the __________ command.

14. You can use the __________  command to add the selected dependent symbols from the xref 
drawing to the current drawing.

15.	 What is the function of the FRAME system variable? Explain.

Exercise 1  							       XBIND
In this exercise, you will start a new drawing and xref the drawings as Part-1 and Part-2, refer to 
Figure 16-35 and Figure 16-36. You will also edit one of the piece parts to correct the size and 
use the XBIND command to bind some of the dependent symbols to the current drawing. The 
parameters of layers for Part-1, Part-2 and ASSEM1 are as follows:

	 For Part-1, set up the following layers:

Layer Name	            Color	 Linetype	

0			   White		  Continuous
Object		  Red		  Continuous
Hidden		  Blue		  Hidden2
Center		  White		  Center2
Dim-Part1		  Green		  Continuous

	 For Part-2, set up the following layers:

Layer Name	             Color	 Linetype	

0			   White		  Continuous
Object		  Red		  Continuous
Hidden		  Blue		  Hidden
Center		  White		  Center
Dim-Part2		  Green		  Continuous
Hatch		  Magenta	 Continuous

	 For ASSEM1, set up the following layers:

Layer Name	             Color	 Linetype	

0			   White		  Continuous
Object		  Blue		  Continuous
Hidden		  Yellow		  Hidden



C
h
a

p
te

r
 1

6
16-27Unders tanding External  Reference s

Figure 16-36  Drawing of Part-2

Figure 16-35  Drawing of Part-1

Hint:

1.	 Xref the two drawings as Part-1 and Part-2 such that the centers of the two drilled holes coincide. Notice 
the overlap, refer to Figure 16-37. Save the assembly drawing as ASSEM1.

2.	 Use the XBIND command to bind the Object and Hidden layers that belong to the drawing Part-1. 
Check again to see if you can make one of these layers current.

3.	 Use the Detach option to detach the xref drawing Part-1. Study the layer again, and notice that the 
layers that were edited with the XBIND command have not been erased. Other layers belonging to 
Part-1 are erased.

4.	 Use the Bind option of the XREF command to bind the xref drawing Part-2 with the assembly drawing 
ASSEM1. Open the xref drawing Part-1 and add a border or make any other changes in the drawing. 
Now, open the assembly drawing ASSEM1 and check to see if the drawing is updated.
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 Answers to Self-Evaluation Test  
1. F, 2. T, 3. F, 4. T, 5. named objects, 6. duplicated, unique, 7. Attach, 8. demand loading, 
9. Overlay, 10. selected

Figure 16-37  Assembly drawing after attaching Part-1 and Part-2


